H P E : Technical white paper
GreenLake

Data protection with HPE StoreOnce
Catalyst and Commvault

Commvault software integration with HPE StoreOnce Catalyst

" A:l:l:i-_'

_ lll-lmnnﬂ ]mmﬁ :

= .'5
il



Technical white paper

Contents

Executive summary

Solution overview

Solution components

Best practices and configuration guidance

HPE Primera storage

HPE StoreOnce appliance

HPE StoreEver MSL6480 tape library

Commvault

Commvault CommServe and Media Agent server

Activating HPE Catalyst
Adding an HPE Catalyst Library

0 N NN o000 00000 W

Applying Data Immutability to HPE StoreOnce Catalyst Stores

Setting ISV Controlled Data Immutability and dual authorization in the HPE StoreOnce user interface

ISV Controlled Data Immutability

B
o o

Including HPE Catalyst storage in a Commvault storage policy

Creating the storage policy for the primary copy

O Y
[SL TS N

Examining a backup to an HPE StoreOnce appliance

=
[00)

Preparing the subclient

=
oo

Monitoring the progress of the secondary copies

N
o

Simulated six-week backup cycle

Synthetic full backups

N N
N

Restore from an HPE Cloud Bank Store

Optimized Restore—Commvault synchronous copy

Optimized Restore—Commvault selective copy

N NN
~N W

Additional CommCell operations using HPE StoreOnce and HPE StoreEver

N
O

N
O

Auxiliary Copy to tape

W
(@]

1-Touch recovery

Live Mount

W
o

Commvault OnePass

N
=

Summary

N
=

Implementing a proof-of-concept with HPE StoreOnce VSA

W
[aiN

Resources

W
N



Technical white paper Page 3

Executive summary

As businesses strive to stay competitive, 24x7 operations are the new norm, and folerance for downtime is rapidly diminishing. As a result,
service-level agreements (SLAs) and uptfime requirements are very stringent, forcing IT organizations to modernize protection and retention
processes 1o align with business objectives. At the same time, rapid data growth, expanding virtual server deployments, and budgetary
pressures further complicate today’s legacy backup and recovery methods. These dynamics, compounded by demands for faster and easier
recovery, require an enhanced approach to data protection.

Hewlett Packard Enterprise primary and secondary storage and Commvault® soffware deliver Tier 1 application resilience, reliable data
profection, enhanced data recovery, and complete data management throughout the lifecycle to improve operational efficiencies.

HPE StoreOnce systems integrate tightly with Commvault CommServe® through HPE StoreOnce Catalyst to enable movement of
deduplicated data across the enterprise—to the public, private, or hybrid cloud.

This capability is delivered by HPE Cloud Bank Storage, a feature of HPE StoreOnce, for long-term retention and reliable, simple, and
efficient disaster recovery.

Benefits of this infegration include:

« Faster backup and recovery: HPE StoreOnce Catalyst offers faster backups than traditional disk-based backup targets because
deduplication processing is distributed between Commvault media servers and the HPE backup storage. Data and application recovery
with HPE StoreOnce are as fast as backups, and Commvault software reduces downtime by using application-aware recoveries.

« Automated disaster recovery with greater flexibility: To protect backup copies in the event of a disaster, HPE StoreOnce Catalyst and
CommServe enable replication of backups to an HPE StoreOnce appliance with HPE Cloud Bank Storage at a secondary location, saving
precious network bandwidth and associated costs. After backups are replicated, CommServe allows data restoration from either local or
remote backup copies on HPE StoreOnce appliances or the cloud.

* Hassle-free data protection: No additional software needs fo be installed in the Commvault software environment. No changes are
required in the Commvault storage policies to deploy HPE StoreOnce Catalyst. Also, Commvault software automatically removes aged
data from the HPE StoreOnce Catalyst Store upon expiration of the retention period.

Target audience

This technical paper is infended for presales consultants, solution architects, and backup administrators designing, implementing, and
managing an end-to-end data protection and data management solution combining HPE storage solutions and Commvault software
technologies. Readers of this paper should have a functional understanding of Commvault information management solutions and the
primary and secondary tiers of HPE storage, including HPE StoreOnce appliances.

Document purpose
This paper demonstrates how Commvault is used to backup and restore a client data set residing on HPE Storage arrays o an
HPE StoreOnce appliance. It also describes creating a secondary copy from an HPE StoreOnce appliance to HPE Cloud Bank.

Solution overview

Hewlett Packard Enterprise and Commvault have formed a strategic global alliance to integrate their leading backup and recovery
and data management solutions with the HPE server and storage portfolio. Commvault IntelliSnap™ technology integrates with
HPE Alletra, HPE Alletra Storage MP B10000, HPE Primera, and HPE Nimble Storage. Commvault Open Systems architecture
supports HPE servers and secondary storage. The Commvault HyperScale™ technology software-defined architecture supports
HPE ProLiant DL380 and HPE Apollo 4200 servers. This solution focuses on the latest integration effort—Commvault Complete™
Backup and Recovery software integration with HPE StoreOnce Catalyst.

HPE StoreOnce Catalyst is a Hewlett Packard Enterprise-developed protocol optimized for backup and restore operations. The
HPE StoreOnce Catalyst server runs on the HPE StoreOnce data protection system. The HPE StoreOnce Catalyst Client is built
into the Commvault Client Intelligent Data Agent (iDataAgent) package. The Commvault Client uses HPE StoreOnce Catalyst to
fransmit backup data to the HPE StoreOnce appliance or other HPE Catalyst targets. HPE StoreOnce Catalyst reduces backup
time while consuming less network bandwidth. In addition, data is deduplicated to consume less storage space on the HPE
Catalyst Store. The Commvault Client can use a Commvault Auxiliary Copy, which interfaces with HPE Catalyst Copy, allowing an
HPE Catalyst Store to be copied fo a secondary store for Commvault archiving purposes.

—


https://www.hpe.com/us/en/storage/storeonce.html
https://www.hpe.com/us/en/storage.html
https://www.hpe.com/us/en/hpe-alletra.html
https://www.hpe.com/us/en/alletra-storage-mp-b10000.html
https://www.hpe.com/us/en/storage/hpe-primera.html
https://www.hpe.com/us/en/storage/nimble.html
https://www.hpe.com/us/en/servers/proliant-servers.html
https://www.hpe.com/us/en/storage/apollo-4000.html
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The integration of Commvault software with HPE StoreOnce Catalyst effectively mitigates the threat of data loss by supporting the 3-2-1
rule for best practice hybrid cloud data protection, which states:

» Maintain three copies of the data: a primary copy and at least two additional copies.
« Store the copies on two different types of media.

* Keep one copy off-site in the event of local hazards or infections within the network.

For example, to apply the 3-2-1 rule for hybrid cloud data protection using Commvault software integration with HPE StoreOnce
Catalyst, the first copy can be on HPE Alletra Storage MP B10000, presented to a Commvault Client. The second copy can be a
primary backup to an HPE StoreOnce appliance. When the primary backup is to an HPE StoreOnce appliance, the third copy can
be on an HPE StoreOnce appliance Catalyst Store or HPE StoreOnce appliance Cloud Bank Store. Potential 3-2-1 backup paths
are illustrated in the following diagrams.

HPE StoreOnce HPE StoreOnce
HPE Primera Appliance Appliance

storage a
= =5 & = & \

Secondary copy
Catalyst Store (Catalyst Copy)

Primary copy

Figure 1. The first copy is on primary storage, second copy is on the local backup appliance, third copy is on the remote backup appliance

HPE Primera HPE Slu.)reOn(e HPE Sn?re(}nce Hyperscaler
storage Appliance Appliance Cloud Store
E v B ® = (83 .
oo (Catalyst Copy) oo
Catalyst Stare Cloud Bank Store

Figure 2. The first copy is on primary storage, second copy on the local backup appliance, third copy on hyperscaler cloud storage, via the local or remote
backup appliance

Note

In Figures 1 and 2, the HPE StoreOnce appliance can be replaced by an HPE StoreOnce VSA. See HPE StoreOnce Backup Appliances for
more information, and the Primary copy can be on any HPE Alletra Storage array (HPE Alletra MP B10000, 2000, 6000, or 5000).

The Commvault software integration with HPE StoreOnce Catalyst supports the following features:

« Integrated installation—Support for HPE StoreOnce is available from Commvault version 11 Service Pack 13 onwards. No additional
software needs to be installed on any server in the Commvault CommCell® environment to enable defining and deploying HPE Catalyst
Libraries. Everything is included with the Commvault software installation kits. In addition, no changes are needed in the Commvault
storage policies to use the HPE Catalyst Libraries; they are simply an addition fo the Library for the Copy drop-down menu when defining
a new storage policy.

» Low-bandwidth backups with HPE Catalyst deduplication—Commvault storage policies specifying a primary backup to a defined
HPE Catalyst Store automatically uses HPE Catalyst low-bandwidth mode to send deduplicated data to the target store. Commvault
Storage Accelerator running on the Commvault Client sends backup data directly to the HPE Catalyst Store without involving a
Commvault media agent.

« Auxiliary Copy operations using HPE Catalyst Copy—Commvault storage policies can specify creating a secondary copy of the data.

o This is called an Auxiliary Copy operation. If the primary backup and the secondary copy are directed to HPE Catalyst Stores, the Auxiliary
Copy operation will automatically initiate an HPE Catalyst Copy. These copies use low-bandwidth mode, so the HPE Catalyst Copy jobs
write unique chunks of data to the target HPE Catalyst Store. The secondary store can be on the same HPE StoreOnce appliance as the
original or a separate HPE StoreOnce appliance in a different location for redundancy. The secondary store can also be on an HPE Cloud
Bank Store for disaster recovery. The Commvault Client is not involved in creating these secondary copies. Auxiliary copies can be set up
to run immediately after the primary copy has been completed or can be scheduled.

—


https://www.hpe.com/psnow/doc/a00100041enw?from=app&section=search&isFutureVersion=true
https://www.hpe.com/us/en/storage/storeonce.html
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« Automated data aging—When the retention period has expired for a Commvault storage policy that uses an HPE Catalyst Store,
Commvault will automatically initiate the HPE StoreOnce housekeeping task to remove the aged data from the store. A primary store and
a secondary store may have different retention policies.

« Synthetic full backups using HPE Catalyst Clone—\When the primary backup target is an HPE StoreOnce appliance, synthetic full
backups do not use any resources from the client system. Instead, Commvault directs HPE StoreOnce to read the backup items written to
the store since the last full or synthetic full backup and rewrite them to a new synthetic full using the HPE Catalyst Clone feature. An
Auxiliary Copy operation can copy synthetic full backups to a separate HPE StoreOnce appliance or HPE Cloud Bank Storage.

Note

Hewlett Packard Enterprise recommends Commvault v11 SP15 or later. Additionally, support for HPE Cloud Bank Storage within
Commvault requires HPE StoreOnce software version 4.1.1 or higher.

Figure 3 presents a high-level view of a CommCell environment showing the logical software components and how data flows from a
Commvault Client to an HPE StoreOnce appliance during a primary backup.

Commvault
Client
CommServe — 2
3 HPE StoreOnce
— 1 a Appliance
L | L R > O
a.o.0
- - Q ¢
il I 4 L J
oo o 4
— Storage Catalyst Catalyst Data oo
Accelerator Library Deduplication Catalyst Store
a
Media Agent

—pp  Client Data
------ »  Deduplicated Dafa

Commvault Metadata

Commvault information

Figure 3. Data flow for writing a backup, primary copy fo an HPE StoreOnce appliance

Key numbered points in Figure 3 are:

1. The CommServe server coordinates all activity in the CommCell environment and maintains a metadata database that manages the
CommCell information.

2. The Commvault Client hosts the applications and related data that are to be protected. Intelligent data agents (iDataAgent) are
installed on the client to communicate with the operating systems and the applications. The client installation automatically includes
the HPE Catalyst Library, which supports the Catalyst protocol. The Commvault Client supports the Commvault Storage Accelerator
package. Storage Accelerator works with the HPE Catalyst Library to direct communications to a target store.

3. The Catalyst Library supports Catalyst deduplication providing low-bandwidth data transfer to an HPE StoreOnce appliance. Both data
and metadata are sent to the store.

4. Deduplicated data is received at an HPE StoreOnce appliance Catalyst Store.

After the backup, the client sends job information and metadata to the media agent.

Note

Typically, client backup data is routed through the media agent; however, with Storage Accelerator the client sends backup data directly to
the target store, thereby improving backup performance.

—
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Solution components

Hewlett Packard Enterprise validated the Commvault software integration with HPE StoreOnce Catalyst in a lab environment. This section
details each principal component incorporated into the solution and concludes with a diagram of the lab setup (see Figure 4).

HPE Primera storage

An HPE Primera A650 storage array, using 24 x 1.92 TB SSDs (Solid State Drives) and OS version 4.1.0.27, was connected to a 16 GB
Fibre Channel (FC) back-end fabric. In addition, thin-provisioned virtual volumes were presented to the Commvault Clients to provide
storage for additional backup data. HPE Alletra Storage MP B10000 also offers intelligent storage for enterprise applications.

HPE StoreOnce appliance

The HPE StoreOnce 5650 backup appliance provided HPE StoreOnce Catalyst Stores and HPE StoreOnce Cloud Bank Stores to the
Commvault CommCell environment. The HPE StoreOnce 5650 appliance ran software version 4.1.1-1849. This version or newer is
required to support Commvault Auxiliary Copy to HPE Cloud Bank Stores. Commvault Auxiliary Copy utilizes the HPE Catalyst Copy
feature. Additionally, HPE Cloud Bank Storage is a licensed feature of HPE StoreOnce.

HPE StoreEver MSL6480 tape library

An HPE StoreEver MSL 6480 tape library provided backup offload to tape. The library was partitioned to give the media agent access to
an LTO-8 tape drive. In addition, a Commvault storage policy was created directing the primary backup fo a Catalyst Store and specifying
a secondary copy whose destination was the HPE StoreEver MSL 6480 tape library.

Commvault

Hewlett Packard Enterprise recommends deploying Commvault v11 Service Pack 15 or a later version when using HPE StoreOnce with
Commvault.

Commvault CommServe and Media Agent server

An HPE ProLiant DL380 Gen10 server, running Microsoft Windows Server 2016, acted as both the Commvault CommServe system and the
media agent server in the solutions lab CommCell configuration. The server was a 20-core (2 x Infel® Xeon® Gold 5115 CPU @ 2.40 GHz)
system with 256 GB of physical memory. The server supported a 1GbE network connection for local management, a 10GbE connection to
the data network, and a 16 GB FC SAN connection to access the HPE Primera array and the HPE StoreEver MSL6480 tape library.

For production environments, Commvault recommends that the Commvault CommServe system and the media agent be deployed on
separate servers. See the CommCell Sizing section of the Commvault v11 Service Pack 15 documentation for recommendations based on
the size of the environment.

Commvault Client servers

The CommCell environment consisted of two Windows clients and two Red Hat® Enterprise Linux® clients. Each operating system ran
clients deployed on one physical HPE ProLiant server and one VMware ESXi™ hosted virtual machine (VM). All client systems used a
10GbE connection to communicate to the primary HPE StoreOnce appliances.

Figure 4 illustrates the components and interconnects used in the solutions lab fo validate the Commvault software infegration with
HPE StoreOnce Catalyst.

1GbE
I, J- | I, J‘ |
i — i ’ — H —
CormServe | m=— Linux | m— '\_u‘«_mdo:us 1 | Linux 1 |
Media Agent S— Cliert | ™= 1 Client VM I I Client VM I I
Windows Client ] o
[x] 1] | S | | S|

HFE StareEver

10GBE Catalyst

Dedupl ca!e@ I-_gig_.l v
on

H = O O
8 Prmary HPE Secondary HPE
HPE Primera StoreCnce StoreOnce

storage

Management
? Network

°T 3

Figure 4. HPE solutions lab CommCell environment
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https://www.hpe.com/us/en/storage/storeever-tape-storage.html
https://documentation.commvault.com/2023e/essential/128043_system_and_hardware_requirements_for_commvault.html
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Best practices and configuration guidance

Activating HPE Catalyst
Before a Commvault HPE Catalyst Library can be assigned to a media agent, HPE StoreOnce Catalyst must be activated on the CommCell
server. The following steps use the Commvault CommCell Console to activate HPE Catalyst:

1. From the CommCell browser navigation tree, right-click the CommCell hostname, and then click Properties from the pop-up menu.

2. From the CommCell Properties panel, select the Additional Settings tab. Click Add at the bottom of this panel to display the Add
Additional Settings panel.

Enter “ActivateHPECatalyst” in the Name field.
The Category, Type, Value, and Details fields are automatically populated. The Enable box is automatically checked.
The Value field displays “false.” This must be changed to “true.”

S

The Comment field is blank by default. This field must have an enftry.

Figure 5 illustrates the completed Add Additional Settings panel to activate HPE Catalyst.

@ Add Additional Settings X
one
Category  |commSenoE.GxGlobalParan w
Type BOOLEAN ~]
Enable [

Comment

jActwate HPE Catalyst

Details

Description: Use this additional setting to show or hide HP Store Once library creation
in the UL

Type: BOOLEAN

Categories: CommServDB.GxGlobalParam

Default Value: false

Allowed Values: false, true

oK Cancel Help

Figure 5. Activating HPE Catalyst 7. Click OK at the bottom of the panel to proceed. The Additional Settings panel will now display the
“ActivateHPECatalyst” entry.
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Adding an HPE Catalyst Library
After HPE Catalyst has been activated, the next step is to add an HPE Catalyst Library to the Storage Resources.

1. From the CommCell browser navigation tree, select Storage Resources = Libraries.
2. Right-click Libraries to display a menu of options.

3. Highlight the Add drop-down menu fo see a list of the available options, and then select HPE Catalyst Library... as shown in Figure 6.

| i CommCell Browser a - Libraries X

oo fire-g10w1 &% fre-giow1 > @0 Storage Resources > [l Libraries >
of Client Computer Groups

+) "B Client Computers Name Status

#1- () Security

5 & Storage R rces Mo Items to display

@ Deduplication Engines

B

- [ L Add > Disk Library...

- 2 Cloud Storage Library...

= Add to Favorites Tape Library...

4 [Bl vaultTracker HPE Catalyst Library...
1| R Policies
i1 #5 Reports Advanced >
+{'g Content Director
4, Workflows

+1- B8 Network Topologies
- @ Dev-Test &DR

Figure 6. Adding an HPE Catalyst Library

Important
If HPE Catalyst Library... is not present in the Add drop-down menu, this indicates that HPE Catalyst has not been activated on the
CommCell server. For activation instructions see the Activating HPE Catalyst section.

After selecting HPE Catalyst Library.., the Add HPE Catalyst Storage panel is displayed, as shown in Figure 7. Adding HPE Catalyst
Storage entails providing a name for the new library and associating the library with an available HPE StoreOnce appliance Catalyst Store.

Note

The Add HPE Catalyst Storage panel does not support creating Catalyst Stores. Catalyst Stores must be pre-created using the
HPE StoreOnce Management Console. For details on how fo create and configure HPE StoreOnce Catalyst and HPE Cloud Bank Stores,
see the HPE StoreOnce User Guide.

After providing a name for the new HPE Catalyst Library in the Name field, use the drop-down menu in the MediaAgent field to specify
which media agent to associate with this library.

Enter the IP address, fully qualified domain name, or CoFC idenfifier of the HPE StoreOnce appliance in the StoreOnce Host field. Specify
the name of a predefined HPE Catalyst Store or HPE Cloud Bank Store in the Store field. With Commvault v11 SP14, a Detect button was
added to the Add HPE Catalyst Storage panel. Click Detect to request Commvault to query the specified host for available stores. Use the
drop-down menu to select the name of the store to associate with this Commvault library.

Note

The Username and Password fields of the Add HPE Catalyst Storage panel are required. When adding an HPE StoreOnce appliance
Catalyst Store or HPE Cloud Bank Store, these credentials were generated when the HPE Catalyst Client was created and assigned access
permission to the HPE StoreOnce appliance Catalyst Store.

For details on how to create and configure an HPE StoreOnce Catalyst Client, see the HPE StoreOnce User Guide.

—


https://support.hpe.com/hpesc/public/docDisplay?docId=a00062048en_us&docLocale=en_US
https://support.hpe.com/hpesc/public/docDisplay?docId=a00062048en_us&docLocale=en_US
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Figure 7 illustrates adding a new Commvault HPE Catalyst Library named “HPE StoreOnce 5650 Store 1.” The new library is associated
with the HPE StoreOnce appliance whose IP address is 10.1.2.10. The library references the “Commvault-Storel” Catalyst Store, which
has been pre-created on the HPE StoreOnce appliance.

Add HPE Catalyst Storage X
General
Name: HPE StoreOnce 5650 Store 1

Device Name: StorageDevice®
Server Type: HPE Catalyst Storage

MediaAgent: |fireg10w1 ~
Access Information

StoreOnce Host: | 10.1.2.10

Username:

Password:

Store: Commvault-Store 1 v

oK Cancel Help

Figure 7. Defining an HPE Catalyst Library for a local Catalyst Store

Adding an HPE Cloud Bank Store follows the same procedure. Figure 8 shows adding a new Commvault library named “HPE Cloud Bank Store.” The

HPE Cloud Bank Store must be predefined on the applicable HPE StoreOnce appliance. The stores available on the HPE StoreOnce appliance are listed in
the Store drop-down menu. The HPE Cloud Bank Store can reference either on-premises private cloud storage or a public cloud service. In this case, the
Store named “Commvault-Cloud-Bank,” defined on an HPE StoreOnce appliance in the solutions lab, references Azure storage.*

Add HPE Catalyst Storage X
General
MName: HPE Cloud Bank Store

Device Mame:  StorageDevice #
Server Type: HPE Catalyst Storage

Mediadgent: | fire-gi0wl w
Access Information

StoreOnoe Host: | 10.1.2.10

Usemname:

Password:

Stare: Commvault-Cloud-Bank v| | Detect |

o Cancel Help

Figure 8. Defining an HPE Catalyst Library for an HPE Cloud Bank Store

1 See the current HPE StoreOnce G4 Support Matrix, HPE StoreOnce G4 Catalyst Cloud Bank Storage, in SPOCK for a list of supported Cloud Service Providers (CSPs).

—
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Applying Data Immutability to HPE StoreOnce Catalyst Stores
With the release of HPE StoreOnce soffware version 4.3.5, enhanced security features have been added to the HPE StoreOnce feature seft.
These features include:

« Dual authorization

« ISV Controlled Data Immutability

ISV (Independent Software Vendor) Controlled Data Immutability is the term given to the ability of backup software to interact and apply
data immutability settings across the HPE StoreOnce Catalyst Stores they are using as backup repositories. In conjunction with dual
authorization, this enhances the security of the data that is stored on the HPE StoreOnce appliance by ensuring that data cannot be
deleted or changed while the retention period set is sfill in force, therefore, removing the possibility that data can be deleted or corrupted
in a malicious ransomware-type attack or accidentally deleted.

To enable both features the HPE StoreOnce appliance needs to be upgraded to a minimum of software version 4.3.5, and Commvault
needs to be upgraded to version 11.30.23.?

After the HPE StoreOnce appliance and CommCell are on the required versions of the software, the enhanced security features are enabled
by default; although they are applied, they do not need to be utilized and will not affect the usage of either system if they are not used.

Setting ISV Controlled Data Immutability and dual authorization in the HPE StoreOnce user interface
Although not required it is a best practice to enable the dual authorization feature on the HPE StoreOnce backup appliance before
enabling the ISV Controlled Data Immutability. When working in conjunction with data immutability, this enhances the level of security of
the HPE StoreOnce appliance by requiring a second person to approve requests to delete backup repositories or items from the
appliance. If dual authorization is not enabled, a blue warning banner will show on the main system dashboard, as per Figure 9.

e System Dashboard

S50-3620

® Dual Authorization is disabled.

Health Status

Data Services ® 0K
License ® 0K
Storage ® 0K

Figure 9. Dual authorization disabled

1. Toenable this feature, first create a security-officer user in the User management sections of the seftings page. After this is completed,
click the Dual Authorization tab on the left-hand side of the Ul to enter the dual authorization setting.

2. Click the three dofts in the top right-hand corner to change the setftings, and o configure the dual authorization, move the slider across to
enable dual authorization. A status message will then be displayed.

3. Next, log in to the HPE StoreOnce appliance using the Security Officer login. In this example a message is displayed at the top of the
screen to indicate that there is a pending action that needs to be approved or denied. To approve this request, click the Dual
Authorization tab. On the far right of the request, click the cog to bring up the action’s menu, then approve or deny the request.

2t might be necessary to conduct some additional upgrades to the Commvault environment to allow the CommCell to be upgraded to version 11.30.23. See Commvault
documentation on how fo do this and what could be required.

—
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ISV Controlled Data Immutability

To get the benefit of having the data stored on the HPE StoreOnce appliance being made immutable, create an HPE StoreOnce
Catalyst Store from the HPE StoreOnce Ul. After giving the new Catalyst Store a name, click the Security Settings opfion from the
main create screen. In the Maximum ISV Controlled Data Immutability Retention (Days) box, set the retention period for data
stored within this Catalyst Store. Finally, click the Create button and add the relevant client user permissions to allow Commvault to
connect to the HPE StoreOnce Catalyst Store.

Security Settings

Store Encryption

Server Controlled Data Immutability
Maximur im ISV Controlled Data Immutability Retention (Days)
xd - +
Client Password Policy
SHA-L hvd

Learn more

“ Defauies

Figure 10. Catalyst Store security settings

Note

There is no need to change the Server Controlled Data Immutability setting as this is for data immutability that is controlled by the
HPE StoreOnce appliance independently of the ISV or backup application.

When the Catalyst Store is created, it is added to Commvault as detailed previously in this document. When the Catalyst Store appears in the
libraries section of the Storage Resources section of the Commvault Command Centre, there are some additional steps that need to be
completed to activate the data immurtability.

Further down the Storage Resources section is Storage Pools. A Storage Pool needs to be created that uses the Catalyst Store so that you
can activate Commvault's WORM Storage lock (WORM Write Once Read Many). To create a Storage Pool, right-click the Storage Pools,
select Add Storage Pool, and then select Disk.

| [ loon

(2 Orphaned Media
-1 RP Store
=5 Storage ]
| @-[® b-an
- @] cv-store Cloud »

Add Storage Pool > I Disk

B vaultTracker Tape
|- | & Policies
Lﬁ} Configuration Policies HyperScale
: ‘! Monitoring Policies Add to Favorites

(=L schedule Polices

S Chmmmmm Plalimims

" Replication Policies ” ‘

Figure 11. Creation of Storage Pool
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From the next screen, select the Storage Resource (the Catalyst Store) from the drop-down menu, then click Next, as show in Figure 12.

@ Create New Storage Pool Wizard X
Configure storage
~Storage ]
(®) Select | 1SW-DI-CVLT ~ I‘

() Create Local hsnode 1-dpn.brdemo.local

() Create Network

Enable Automated Mount Path Detection

Path Browse

Cancel <Back | Finish

Figure 12. Selecting the storage for the Storage Pool

The next screen is ignored because setting encryption from Commvault is not required. Click Next to go to the Storage Pool creation
summary screen and then click Finish.

@ Create Mew Storage Pool Wizard *

Review your selections.

Name: ISV-DI-CVLT

Primary Copy: Primary_Global
Storage: ISV-DI-CVLT
Deduplication: Mo

Software Encryption: Mo

Click Finish to create the Storage Pool

Cancel | < 'B.at':k Next =

Figure 13. Summary screen
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The Storage Pool is now created and ready to be added to the storage policy. An entry for the Storage Pool is also created in the storage
policy’s section. The next step is to activate the Commvault WORM Storage Lock option. This is done by right-clicking the Storage Pool
and selecting Properties = Storage Pool Copy, shown in Figure 14.

E}g Storage Pools
| &[] b-andr-cv-test
El cy-store
= @ 15
| i Add >
G- (B vaultT View *
=) | & Policies
hi..- Confid Start Ower
- % Moritd Delete
@i HEsh _F;.';)F;‘E’ties ? Storage Pool
- (5L Sched ; : :
w25 Stora Add to Favorites § Storage Pool Copy |
&'}.‘-H Subdlient Policies ]

Figure 14. Activating the Commvault WORM Storage Lock option

From the Storage Pool Copy properties, it is possible to apply the WORM Storage lock option to the overall Storage Pool. From here, apply
the retention period to the actual backup policy so that data is protected by data immurtability.

To create a storage policy that is using the ISV Controlled Data Immutability, go to the Storage Policies section of the Commvault
CommCell Ul, then right click Storage Policies and select Create New Storage policy. Run through this as usual until reaching the Select
Storage Pool; by default, there is a tick in the Use Existing Storage Pool opfion, and then from the drop-down menu, select the new

HPE StoreOnce Catalyst Store that was created at the start of this process. storage pool that has the WORM Storage lock applied to it. On
the next screen change the retention period to the desired amount, this can be any amount up to the maximum retention period set in the
HPE StoreOnce Catalyst store.?

@ Create Storage Policy Wizard X

Enter the streams and retention criteria

Number of Device Streams: _%J

Choose the Primary Copy's Aging Rules:

rRetention -

Infinitef 30 ii Days i] :| Cydes

Cancel < Back Finish

Figure 15. Setting the storage policy’s retention period

S Commvault still has the concept of a “cycle” in the storage policy creation. One cycle is defined as the period between full backups. If the retention period is going to be longer
than this, set the cycles to O.

—
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Confirm at the summary screen that you have set the correct retention before you finish.

Having one retention period for all data is not feasible or sensible. Different types of backups require different retention periods. For
instance, daily backups might require a 30-day retention period, weekly backups a 1-year retention, and monthly backups 4 or 5 years for
retention. This can also be accommodated with one storage policy.

HPE StoreOnce Catalyst store’s archive better deduplication when data of the same type is stored in a single store, no matfter what the
retention period is set to. When setting the “Maximum ISV controlled DI” retention figure on the HPE StoreOnce Catalyst store this figure is
the maximum length of time that the data is going to be marked as immutable by the HPE StoreOnce, but Commvault is able to set a shorter
retention period for each item that is stored. So, if data in a store needs to be retained for a week, a month or a year this is possible in each
individual HPE Catalyst store, as the retention period is set per item not per HPE Catalyst store.

Figure 16 shows a primary copy or daily backup with a retention time of 30 days, a weekly backup copy with retention of 90 days, and a
monthly backup copy with a 1-year retention period.

[=] Content

Copy Copy Type Status Default Library MediaAgent Default Drive Pool Scratch Pool Retain For

|| Primary Primary ISV-DI-CVLT jupe NfA N/fA 30 days, 0 cydes
_% monthly Selective ISV-DI-CVLT-monthly jupe SR N/fA 365 days, 0 cydes
_g weekly Selective ISV-DI-CVLT-weekly jupe NfA N/fA 90 days, 0 cydes

Figure 16. Retention fimes for backup copies

Including HPE Catalyst storage in a Commvault storage policy

A Commvault storage policy manages the data protection lifecycle of the content of any Commvault subclient associated with the policy.
The storage policy defines a primary copy and any optional secondary copy. Commvault subclient backups are written to the library
assigned to the primary copy, typically a local library providing for quick retrieval. An Auxiliary Copy specifies that a secondary copy of
the primary backup is made after successful completion of the primary backup. Auxiliary copies are typically directed to libraries in other
locations, including cloud storage, to provide business continuity or disaster recovery. The primary and secondary copy can specify
different retention fimes to match an organization’s SLAs.

Storage policies can also specify other options such as deduplication, compression, and data encryption. Selecting these options has no
effect when an HPE Catalyst Library is set in the policy (primary or secondary). In the case of backups to HPE Catalyst Stores, the
following apply:

o Commvault backups to HPE Catalyst Stores turn off Commvault deduplication. Backups to HPE Catalyst Stores automatically use Catalyst
low-bandwidth fransport, which means the data will be deduplicated and compressed using Catalyst.

« For HPE StoreOnce appliances, if data encryption is desired, the following security features are offered: Data at Rest Encryption, Data in
Flight Encryption, and Secure Erase. Data at Rest Encryption and Data in Flight Encryption require the Encryption license, whereas Secure
Erase is available without a license.

The remainder of this paper uses the following two Commvault storage policies created in the solutions lab as part of validating the
Commvault software integration with HPE StoreOnce Catalyst:

e “Storel”

A Commvault storage policy named “Storel” consists of a primary copy o an “HPE StoreOnce 5650 Store 1" HPE Catalyst Library, which
references the “Commvault-Storel” Catalyst Store (see Figure 7).

e An Auxiliary Copy, named “Secondary—Cloud Bank Store,” references the “HPE Cloud Bank Store” library, which references the
“Commvault-Cloud Bank” HPE Cloud Bank Store. The term “secondary copy” is used to reference this Auxiliary Copy.

« No secondary copy is created for this policy.

Note

The Commvault media agent also serves as a Windows client. “Storel” is the selected storage policy for “TestData” subclient backups.

—
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Creating the storage policy for the primary copy
To create a new storage policy:

1. Inthe CommCell Console navigation tree, navigate to Policies = Storage Policies.

2. Right-click Storage Policies and select New Storage Policy from the menu of options. This displays the Create Storage Policy Wizard
panel. After selecting Data Protection, Archiving as the Storage Policy Type, and providing a Storage Policy Name, click Next to
display the Select the library panel. The Library for Primary Copy drop-down menu lists all the libraries available o assign to this policy.

Figure 17 shows selecting the “HPE StoreOnce 5650 Storel” HPE Catalyst Library (created in Figure 7) as the primary copy library for the
new “Storel” storage policy.

@ Create Storage Policy Wizard X

Select the library

Lbrary for Primary Copy: | pE Cloud Bank Store v

[HPE Cloud Bank Store ~
[HPE StoreOnce 5650 Store2
[HPE StoreOnce 5650 Store3 b

Figure 17. Selecting HPE Catalyst Library when creating the primary “Storel” storage policy

When the wizard completes, the new storage policy will be listed along with all other policies under the expanded Storage Policies item in
the CommCell browser navigation tree.

Creating the storage policy for the secondary copies

If a Commvault storage policy includes an Auxiliary Copy, Commvault will automatically schedule an Auxiliary Copy operation to be performed after
the successful completion of the primary backup. In the case where the primary and secondary copies are targeted at HPE StoreOnce Libraries, the
Auxiliary Copy operation will invoke HPE Catalyst Copy to copy backup data from the primary Catalyst Store to the auxiliary Catalyst Store

(HPE Cloud Bank Store). HPE Catalyst Copy jobs are performed using low-bandwidth mode, only writing unique chunks of data to the target Catalyst
Store. HPE Catalyst Copy frees the Commvault Client from handling the overhead of moving data off-site.

Figure 18 shows the data flow in an Auxiliary Copy using an HPE Catalyst Copy operation from an HPE Catalyst Store to an HPE Cloud Bank
Store as the farget destination.

1

CommServe

i
(1M

HPE StoreOnce HPE StoreOnce
Appliance Appliance
P —
—

B auams 2 S UGG JS— >
6 ¢ o.0.0 Hyperscaler
on ¢ Cloud Store
ono
Catalyst Store Cloud Bank Store

Commvault Client Catalyst Copy
Media Agent

N

""""""""" ¥ Catalyst Deduplicated Data
Commvault Mefadata

CommCell information

Figure 18. Data flow for writing a backup secondary copy from an HPE StoreOnce appliance to another HPE StoreOnce appliance
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Key numbered points in Figure 18 are:

1. The CommServe server coordinates the backup activity in the CommCell environment.
The Commvault Client initiates the backup. In Figure 18, the media agent is also serving as the client.
The client’s storage policy directs the primary copy to a local HPE StoreOnce appliance Catalyst Store.

The client’s storage policy specifies an Auxiliary Copy, which performs an HPE Catalyst Copy to an HPE StoreOnce appliance.

R wN

This shows the deduplicated data being received at an HPE StoreOnce appliance Cloud Bank Store, which uses PUT requests to
write the data to the cloud in a Hyperscaler cloud object store.

6. The client and media agent are updated with the job information and metadata.

To add an Auxiliary Copy to an existing storage policy, right-click the storage policy name and select All Tasks = Create New Copy.
Figure 19 illustrates creating a new Auxiliary Copy for the “Storel” storage policy.

“._—}_:3 Storage Policies
~L| CommServeDR

|| Storey :

i [=p All Tasks 2 Run Auzxiliary Copy

B e View ? Run Content Indexing
|| Storeq

- [5§ Subciient Add to Favorites Run Data Verification

- [ vaultTrack Properties Create Mew Copy
- | Virtual Machine Policies
—}-"‘T Reports

Elm My Reparts Clone

-5l Other Reports Delete
H-{ g Content Director
T, Workflows

@--_ﬂ Interactions
- B8 Metwork Topologies
- | ¢y Dev-Test & DR

Create Mew Snapshot Copy

Figure 19. Adding an Auxiliary Copy to the “Storel” storage policy

Selecting Create New Copy in Figure 19 opens a panel for creating the copy. See Figure 20 for creating “Secondary—Cloud Bank Store.”
Creating the secondary copy to an HPE Cloud Bank Store

1. Enter the Copy Name and Description, then expand the Add drop-down menu and select Disk, as shown in Figure 20.

@
L2

Create Mew Storage Policy Copy X

Copy Details

Copy Name: Secondary - Cloud Bank Store

Storage Pool: ~

Disk
Metaliic Cloud Storage
Auxiliary copy to HPE Cloud Bank Store Cloud Storage

Tape

Description

HyperScale

Cancel < Back Next > Finish

Figure 20. Creafing a new secondary copy for the HPE Cloud Bank Store

Note

When adding a new Storage Pool for HPE Catalyst Libraries, select Disk and not Cloud Storage from the drop-down menu.
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2. Click Next, and the Create New Storage Pool Wizard appears, as shown in Figure 21, then enter the Storage Pool Name.

&) Create Mew Storage Pool Wizard X
9

Enter the storage pool name

Storage Pool Name: o cloud Bank Pool|

Cancel < Back Finish

Figure 21. Creating a new Storage Pool for the HPE Cloud Bank Store

3. Click Next and select the “HPE Cloud Bank Store” library for the new pool, illustrated in Figure 22.

f @ Create Mew Storage Pool Wizard X
Configure storage
- Storage
(@) Select HPE Cloud Bank Store v

(O Create Local  |HpE Cloud Volumes Backup Store

HPE StoreOnce 5650 Store 1
1 Path Browse

() Create Network

Enable Automated Mount Path Detection

Cancel | | <Back Finish

Figure 22. Selecting the existing “HPE Cloud Bank Store” library
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Examining a backup to an HPE StoreOnce appliance

This section provides a detailed example of creating and launching a full backup of a Commvault subclient using a storage policy that
targets HPE StoreOnce libraries pointing to an HPE StoreOnce appliance Catalyst Store for the primary copy, with secondary copies to
an HPE Cloud Bank Store. This section also describes HPE StoreOnce and Commvault resources available to monitor the progress and
results of the backup and copy operations.

Preparing the subclient

With a storage policy defined, the next step is to prepare the Commvault subclient for backup. This involves selecting the data to be backed
up, specifying which storage policy to use, and specifying advanced options for performance.

In the HPE solutions lab environment, a thin-provisioned HPE Primera virtual volume was presented fo the Windows media agent server
(which also acted as the client computer).

For backups to an HPE StoreOnce appliance, a 200 GB data set was created on the mounted volume (F:\dataset). A subclient named
“TestData” was added to the “defaultBackupSet” for the client computer. The content and storage policy properties of this subclient were
modified as follows:

1. Select TestData = Properties to display the Subclient Properties of the TestData panel.
2. From the Content tab, F:\dataset was specified as the content to be backed up.

From the Storage Device - Data Storage Policy tab, “Storel” was selected as the Storage Policy. This policy specifies that the
primary copy of the data will be written to an HPE Catalyst Store, with secondary or Auxiliary Copies of the data written to an
HPE Cloud Bank Store (see Figure 22).

3. An Advanced button is displayed at the bottom of the Subclient Properties panel. Click this button to display the Advanced Subclient
Properties screen as shown in Figure 23. Select the Performance fab to access key performance settings. Figure 23 highlights the
following performance settings selected for the “TestData” subclient:

a. The Number of Data Readers specifies the number of simultaneous backup data streams allowed for this subclient. The default
value is two data readers. Figure 23 shows this was increased to four data readers. The HPE Primera volume can support a more
substantial number of data readers, and HPE StoreOnce performance benefits from an increased number of parallel input streams.
Specify a value that maximizes performance without compromising client-server resources.

b. Because backups for the “TestData” subclient will be reading from a single Windows physical drive, checking Allow multiple data
readers within a drive or mount point will allow all four data readers to access the F:\ volume.

c.  The Application Read Size values range from 64 KB to 4096 KB. The default value is 64 KB. No perceptible performance difference
was noted in the HPE solutions lab between settings of 2048 KB or 4096 KB.

© Advanced Subclient Properties of TestData X

Retenton Pre/Post Process InteliSnap Operations  Advanced Options  Performance

Number of Data Readers 24
] Alow multiple data readers within a driyle or mount point.

Resource Tuning

Improvement in performance is resource dependent.
Spedfy the number of Network Agents the chent wil use to transfer data.
For Windows and UNIX , the range is 1-4 with default value of 2.

Network Agents: | 2/

[ Thwottle Network Bandwidth (MB/HR)

0

A Apphication Read Size : 0% S|kB

Figure 23. Subclient performance settings
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Initiating a backup to an HPE StoreOnce appliance Catalyst Store To start the full backup for the “TestData” subclient:

SO O

Right-click the subclient name and select Backup from the menu.

Click the Full button on the Backup Options for Subclient: TestData panel.

Click OK to start the backup.

Select Job Controller = Show All Jobs to display the progress of the primary backup job.

Double-click the job entry fo display job detfails.

The Progress tab provides information such as the size of the application, percent complete, number of files transferred, file currently
being backed up, and current and average throughput. The Streams tab displays the number of streams in use, the current file being
backed up on each stream, and the throughput per stream. The number of streams should match the number of data readers set in the
Advanced Subclient Properties of TestData panel (see Figure 23).

When the job successfully completes, select Storage Policies - Storel = Primary = View = Jobs to display a summary of the
just- completed full backup.

Log in to the HPE StoreOnce Management Console of the primary HPE StoreOnce appliance and select Data Services = Catalyst
Stores > Commvault-Storel to display the Overview panel for the primary Catalyst Store.

Figure 24 shows the summary results for the completed full backup. The overview includes the User Data Stored (total data written by
the backup application before the data was deduplicated), the Size on Disk (the amount of disk space used to store all the deduplicated
data), and the corresponding Store Dedupe Ratio (the fotal amount of data written by the backup application before deduplication
divided by the actual capacity used after deduplication).

1} - -Stol
focatiin & & Catalyst Stores - Commvault-Storel

jion Dashboard

1.4:1 201.2GiB 135.7GiB 15

Store Dedupe Ratio User Data Stored Size on Disk Items

uor3 No Limit sical Storage Guora No Limit

Figure 24. Overview of Catalyst Store after a first full backup of a 200 GB data set

8.

Select Data Services > Catalyst Stores > Commvault-Storel - Items to display the Catalyst items maintained in this store.

Figure 25 highlights some information displayed in the Tag List column, which helps to identify the source of the backup, such as
Commvault Client name, Commvault Job ID, and Commvault media agent hostname.

- Catalyst Stores - Commvault-Storel

& strontium1
Overview Details Permissions Items Backup/Restore  Outbound Copy Inbound Copy
C B v

Modified temn Tag List - Cfl

Data Size
3/5/2019 TMBXB8_02.06.2019_16.09|CV_MAGNETIC|V Afid:151 Appld:17 AppType:1 ArchGroupld:5 BackupLevel:1 ChunkNo:omp\ DK
3:04 pm _95|CHUNK_529|1.data ete Copyld:{Job:468 WAClient-fire-g10wl MAHos1:10.1.2.66
3/5/2019 TMBXB8_02.06.2019_16.09]CV_MAGNETICIV Afld:151 AType:l ArchGroupld:S BackupLevel:1 ChunkNo:1 Client:fire-g10w1 Compl so88
3:04 pm _95|CHUNK_529l.idx ete Copyld:4 Job:46§MAClient:fire-g10wTYMAHos1:10.1.2.66
3/5/2019 TMBXB8_02.06.2019_16.09|CV_MAGNETIC]V Afld:151 Appld:17 AppTypeL A roupld:5 BackupLevel:1 ChunkNo:1 Client:fire-g10w1 Compl i MiB
3:04 pm _95|CHUNK_529|.meta ete Copyld:4 Job:468 MAClient:fire-g10wl MAHos:10.1.2.66
3/5/2019 TMBXB8_02.06.2019_16.09|CV_MAGNETIC|V Afld:150 Appld:17 AppType:43 ArchGroupld:S BackuplLevel:1 ChunkNo:1 Client:fire-g10w1 Com e
3:04 pm _95|CHUNK_527|1.data plete Copyld:4 Job:468 MAClient:fire-g10w1 MAHes:10.1.2.66
3/5/2019 TMBXB8_02.06.2019_16.09|CV_MAGNETICIV Afld:150 Appld:17 AppType:43 ArchGroupld:5 BackupLevel:1 ChunkNo:1 Client:fire-g10w1 Com 5e55KiR
3:04 pm _95|CHUNK_527l.idx plete Copyld:4 Job:468 MAClient:fire-g10wl MAHos1:10.1.2.66
3/5/2019 TMBXB8_02.06.2019_16.09|CV_MAGNETIC]V Afld:150 Appld:17 AppType:43 ArchGroupld:5 BackupLevel:1 ChunkNo:1 Client:fire-g10w1 Com 45.9MiB
3:04 pm _95|CHUNK_527|.meta plete Copyld:4 Job:468 MAClient:fire-g10w1 MAHost:10.1.2.66

Figure 25. Catalyst Store [tems “Tag List” contains client name, job id, and media agent name
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Monitoring the progress of the secondary copies

Starting with Commvault v11, the secondary copies are automatically associated with the by default runs the Auxiliary Copy job at 30-minute
time intervals.” Selecting Storage Policies System Created Autocopy = Storel - Secondary - <Cloud Bank> schedule policy, which
Store - View = Jobs will show “To Be Copied” as the job status if the job is waiting for the schedule. When the Auxiliary Copy job is
launched, the Job Controller will show an Auxiliary Copy job that has started and is in progress.

To see the HPE Catalyst Copy activity from the primary HPE StoreOnce appliance, log in to the HPE StoreOnce Management Console and
select Data Services > Catalyst Stores > Commvault-Storel - Outbound Copy. This will display the multiple HPE Catalyst Copy jobs
in progress as shown in Figure 26. The column selector icon is highlighted in Figure 26. The column selector is used to add the Target
Store Name column to the display.

i = Catalyst Stores - Commvault-Storel
strontiuml
Overview Details Permissions Items Backup/Restore Outbound Copy inbound Copy

Status Queued Source item Source Item Size Percentage Completed Target Store Name
D @ Running 2/8/2019 11:35 am TMBXBS8_02.06.2019_16.09|CV_MAGNETIC|V_7|CHUNK_16|Ldata 50 GiB 20% Commvault-Cloud-Bank @
D @ Running 2/8/2019 11:35 am TMBXB8_02.06.2019_16.09|CV_MAGNETIC|V_S|CHUNK_18|1.data 50GiB 20% Commvault-Cloud-Bank @
D @® Running 2/8/2019 11:35 am TMBXB8_02.06.2019_16.09|CV_MAGNETIC|V_&/CHUNK _17|1.data 50GiB 20% Commvault-Cloud-Bank @
I:I @ Running 2/8/2019 11:35 am TMBXBS_02.06.2019_16.09|CV_MAGNETIC|V_8|CHUNK _15|1data 50GiB 20% Commvault-Cloud-Bank @
D @ Completed 2/8/2019 11:31am TMBXBS_02.06.2019_15.09|CV_MAGNETIC|V_8|CHUNK_27|1data 253 MiB 100% Commvault-Cloud-Bank @

Figure 26. VViewing Outbound HPE Catalyst Copy job information

Note
The example farget views are for a secondary copy to an HPE Cloud Bank Store.

For secondary copies to an HPE Cloud Bank Store, to view the HPE Catalyst Copy jobs from the copy target point of view, log in to the
HPE StoreOnce Management Console on the secondary HPE StoreOnce appliance and select Data Services = Cloud Bank Stores >
Commvault- Cloudbank = Inbound Copy. Use the column selector to add Source Address and Source Store Name to the display.

Figure 27 shows the HPE StoreOnce Management Console Overview panel for the HPE Cloud Bank Store after the completion of the
Auxiliary Copy job. The overview includes the Size in Cloud metric (the size of the HPE Catalyst Store on the HPE Cloud Bank service
provider).

,:; Cloud Bank Stores - Commvault-Cloud-Bank

€

Overview  Defails  Permissions  Iem: Backup/Rest

1.9:1 201.2GiB 102.8GiB 1.4GiB 15

Store Dedupe Ratio User Data Stored Size in Cloud Size on Disk Items

2 No Limit Physical Storage Quota; Ne Limit

Figure 27. Overview of completed HPE Catalyst Copy job to an HPE Cloud Bank Store

“One way to view this schedule is to select Storage Policies > Storel > View > Schedules.
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From the HPE StoreOnce Management Console of the secondary HPE StoreOnce appliance, select Reports = Cloud Bank.

Figure 28 shows a Cloud Bandwidth Utilization chart displaying the uploaded bytes for the completed HPE Catalyst Copy job.

Reports
;] atrantuml @ Custom
Backup/Restore  Replication/Copy  Cloud Bank Capacity Resources Interface Custom  Scheduled
Cloud i ilization for 1
Time Range (2872019 11,30 am USMounten - 2/8/2019 12123 pm US/Mountain]
m
+ achex tes W@

Figure 28. “Cloud Bank” bandwidth utilization for initial HPE Catalyst Copy job

Figure 29 shows a second HPE Cloud Bank Storage report breaking down the request types for communications to the cloud service
provider.

Cloud Requests for strontium1
arge [2/8/2019 11:30 am USMounten - 2/8/2019 12:25 0

Figure 29. Breakdown of request types for the initial HPE Catalyst Copy job

Simulated six-week backup cycle

Conftinuing from the previous section, a simulation was set up in the HPE solutions lab to perform a six-week backup cycle with a two-week
data retention period on the primary copy to an HPE StoreOnce appliance. Each cycle consisted of one full backup followed by six daily
incremental backups. A 3% data change was made to the F:\dataset content for the “TestData” subclient between each backup. At the end
of each cycle the user data stored, the size on disk, and deduplication ratios were captured from the primary HPE StoreOnce appliance for
the “Commvault- Storel” store. Commvault data aging ran at the end of each cycle to expire any data older than the retention period.
Figure 30 shows a graph comparing the user data stored and size-on-disk values captured at the end of each daily backup.

The user data stored value increases as backups are completed for weeks one, two, and three. When data aging runs at the end of week
three, the cycle for week one expires. Data aging invokes the housekeeping task on the HPE StoreOnce appliance to remove the week-one
cycle data from the HPE Catalyst Store. This causes the drop in the user data stored and size-on-disk values.

The week-four cycle executes, and again when data aging runs at the end of week four, there are three complete cycles, so the week-two
cycle is expired. Data aging again runs housekeeping on the HPE StoreOnce appliance, returning the user data stored and size-on-disk
values fo the equivalent of two full cycles.

The pattern is repeated for weeks five and six. The size-on-disk component of the Figure 30 graph shows the same reduction in data as
data aging causes one cycle to be expired starting at week three.

—
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GB

Figure 30. User data stored and size on disk during the simulated six-week backup cycle with two-week retention

Figure 31 shows how data aging affects the HPE Catalyst Store deduplication ratio during this six-week cycle.

Figure 31. Deduplication ratio during the simulated six-week backup cycle with two-week retention

Store Dedupe Ratio

HPE Catalyst Store User Data Stored and Size on Disk
6-week backup cycle
2-week data retention
200 GB data set - 3% daily change

Week 2 Week 3 Week & Weeak 5 Week &

wewUser Data Stored ===5ize On Disk

HPE Catalyst Store Deduplication Ratio
6-week backup cycle
2-week data retention
200 GB data set - 3% daily change

Week 1 Week 2 Week 3 Week 4 Week 5 Week &

——Dedupe Ratio

Synthetic full backups
Commvault synthetic full backups consolidate the latest full backup with any subsequent incremental backups into one backup file. This
makes restore operations easier and more efficient. Commvault software integration with HPE StoreOnce Catalyst supports synthetic full
backups. When the primary farget of a synthetic full backup is an HPE Catalyst Store, no data is read from the client system. Instead, a

Catalyst Clone operation reads the required backup items from the store and creates a new consolidated backup object.

Page 22

To observe the Catalyst Clone operation, log in to the HPE StoreOnce Management Console of the primary HPE StoreOnce appliance and
select Data Services > Catalyst Stores - <store name> > Backup/Restore. Click the column selector icon (see Figure 26) and choose
clone operation-related columns such as Clone Duration and Logical Data Cloned.

When the synthetic full operation is complete, the user data stored and size-on-disk values for the HPE Catalyst Store will increase by an
amount that reflects the equivalent capacities as if a full backup had been performed. Commvault does not automatically remove the original
full and incremental backups after a synthetic full; the previous full and incremental backups are subject to the retention period defined for
the storage policy.

—
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Restore from an HPE Cloud Bank Store
If data is expired (aged off) or accidentally deleted from the primary HPE Catalyst Store, it is possible to retrieve the data from the Auxiliary
Copy maintained on a secondary HPE Catalyst Store. There are two types of restores:

» Direct Restore—Direct Restore copies data from the secondary HPE StoreOnce appliance directly fo the client host system, bypassing
the primary HPE StoreOnce appliance. Data is rehydrated at the secondary HPE StoreOnce appliance before it is sent to the client. Direct
restores are most valuable when restoring from HPE Cloud Bank Storage residing on an on-premises object store. Data is fransferred to
the client over a local high-speed LAN and there is no service provider fee to pay when reading from an on-premises store. Performing a
Direct Restore from HPE Cloud Bank Storage that is using an off-site Cloud Service Provider could result in increased costs due to the
increased reads performed in the cloud to rehydrate the data.

» Optimized Restore—Optimized Restore is an HPE Catalyst Cloud Bank Storage feature that reduces the cost and time for restores from
the cloud. An optimized restore is an HPE Catalyst Copy from the HPE Cloud Bank Store to a local HPE Catalyst Store followed by the
restore operation. HPE Catalyst Copy moves only the chunks of duplicated data missing from the local store. The missing data is not
rehydrated during the HPE Catalyst Copy operation. Optimized Restore results in lower bandwidth utilization (a benefit in WAN
environments) and saves costs relative to the fees that service providers typically charge for reading data from the cloud. Recovery of
the client data can then proceed from the local HPE Catalyst Store via a direct restore.

Figure 32 provides a high-level overview of Optimized Restore from HPE Cloud Bank Storage.

HPE StoreOnce HPE StoreOnce

Commvault Appliance Appliance Object Store

Client ? - ~ (Azure/53)

=] @ =95 [E] ! E‘a 8] . €

ono e.0.0 on s 1
-] Catalyst Store Retrieve unique data
HPE Cloud Bank
o S
Store
Catalyst Copy
'1 Compare requested items in local Catalyst Store

with HPE Cloud Bank Store

& GET request refrieves unique, deduplcated data

B Client data missing from local Calalyst Store is
retrieved from HPE Cloud Bank Store

Figure 32. Catalyst Optimized Restore

There are two methods for performing an Optimized Restore: Commvault synchronous copy and Commvault selective copy.

Optimized Restore—Commvault synchronous copy

A Commvault synchronous copy is used when there is a need to resynchronize the local HPE Catalyst Store with all the backup jobs
stored in the HPE Cloud Bank Store. The following steps use the HPE solutions lab environment to describe how to set up and initiate
an HPE Catalyst Copy, duplicating all the data from the HPE Cloud Bank Store to the local HPE Catalyst Store.

1. From the CommCell browser, select Storage Policies = Storel - <copy name> = View = Jobs to view a list of all backup jobs
associated with both the primary and secondary copies. All the backup jobs on the secondary copy will be restored by this Commvault
synchronous copy operation.

2. Torestore all the data from the HPE Cloud Bank Store to the local HPE Catalyst Store, a third copy must be created for the “Storel”
storage policy.

a.  From the CommCell browser navigation tree, select Storage Policies = Storel. Right-click and select All Tasks > Create New Copy.

b. Enter a Copy Name and choose a target Storage Pool. A new Storage Pool must be created the first fime, which should point to the
Default Destination “HPE StoreOnce 5650 Storel” (the local HPE Catalyst Store).

c. Click Next twice, then click Finish to complete the creation. Select Storage Policies = Storel. Right-click and select Properties.
Figure 33 shows the Copy properties panel for the “Synchronous-Restore-Cloud-Bank-Store” Copy for the “Storel” storage policy.
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@) Storage Policy Copy properties of Synchronous-Restore-Cloud-Bank-Store x
Associations Media Advanced Audit
General Retention Copy Policy DataPaths Data Path Configuration  Ausdliary Copy Fallen Behind
Copy Information
Copy Name: Synchronous-Restore-Cloud-Bank-Store
[] Primary Copy Active
[] selective Copy [] WORM Copy
Use Global Storage Policy HPE StoreOnce 5650 Pool
-Default Destination -
Library: HPE StoreOnce 5650 Store 1
MediaAgent: fire-g10w1
Drive Poal: MNJA
Description
QK Cancel Help

Figure 33. Creating a third copy, “Synchronous-Restore-Cloud-Bank-Store,” for the “Storel” storage policy

3. At the top of the Copy Properties panel, select the Selective Copy fab. In the Source Copy subpanel of the new display, check the
Specify Source for Auxiliary Copy box. In the drop-down menu for this field, select “Secondary — Cloud Bank Store” as the source for
the Auxiliary Copy. Clicking OK brings up a panel, shown in Figure 34, asking for confirmation that the source for the Auxiliary Copy is
not the primary copy. Click Yes to complete the definition of the new copy and return to the CommCell browser.



Page 25

Technical white paper

® Copy Properties (Storage Policy : Storel) X
- Advanced
General Retention Auxiliary Copy Fallen Behind
Backup Selection
[~] All Backups
Backups On and After: Friday, March 8, 2019 -
@ Confirm X
‘.ol You have selected a different source copy for Auxiliary copy.
Do you want to continue?
No
OK Cancel Help

Figure 34. Select “Secondary - Cloud Bank Store” as the copy source for the new Auxiliary Copy “Synchronous-Restore-Cloud-Bank-Store”

4. The CommCell browser automatically displays a summary panel (shown in Figure 35) listing the copy definitions associated with the
“Storel” policy. Note the designated Copy Type for each copy.

|| Store1l x
oo freglowl > | § Policdes > i Storage Polides > | | Storel >
[ Content
Copy Copy Type Status Default Library
Primary Primary M HPE StoreOnce 5650 Store 1
_# secondary Synchronous M HPE Cloud Bank Store
M HPE StoreOnce 5650 Storel

# Synchronous-Restore-Cloud-Bank-Store  Synchronous

Figure 35. Synchronous copy added to the "Storel" storage policy

5. The final step is to run the new Auxiliary Copy. From the CommCell browser. Select Storage Policies > Storel = All Tasks = Run

Auxiliary Copy. This displays the Auxiliary Copy Job Options panel shown in Figure 36. Use the drop-down menu in the Select Source
MediaAgent field o select the source media agent. From the Copy Selection subpanel, deselect All Copies and click the Select A Copy
radio button. Use the drop-down menu to choose the name of the Auxiliary Copy to run. The newly created third copy (from Figure 35),

“Synchronous-Restore-Cloud-Bank-Store,” is set as the copy to run for this Auxiliary Copy job.

—
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@ Auxiliary Copy Job Options x

General Job Initiation

Select a Storage Policy Store1

= :

Copy Selection

(O Al Copies

eI
Synchronous-Restore-Cloud-Bank-Store ]

Number Of Readers

(O Number Of Streams 1 :]

(®) Allow Maximum

[[] Start New Media

[[] Mark Media Full On Success

se Most Recent Full Backup For Auxcopy
[[] wait For Al Parallel Copy Resources
[ Use Scalable Resource Allocation

[[] Skip jobs that failed data verification
Cancel Advanced (@ save AsSaipt | | Help

Figure 36. Specifying the copy to run for the duplication copy job

6. Click OK fto initiate the Auxiliary Copy.

7. To confirm the copy operation progress, use the appropriate HPE StoreOnce Management Console to review the Inbound Copy jobs for
the local HPE Catalyst Store. Review the Outbound Copy jobs for the HPE Cloud Bank Store. Select Reports = Cloud Bank to review
the bandwidth utilization and requests graphs.

8. Review any metrics from the public cloud service provider to determine how much data has been read from the cloud. The total data
read will confirm that the Optimized Restore has only copied the chunks of data that were missing from the primary store.

9. When the Auxiliary Copy job is finished, select Storage Policies > Storel > Synchronous-Restore-Cloud-Bank-Store - View >
Jobs to confirm that all jobs have been restored from the HPE Cloud Bank Store. Right-click a specific job in the list to initiate any
desired Browse and Restore operations.

Important

After the recovery is complete, be sure to deactivate the third copy to prevent it from automatically running as part of any regularly
scheduled backup operation. In the CommCell browser, right-click the name of the third copy and select Properties. In the Copy
Information panel of the Store Policy Copy properties panel, uncheck the Active item.
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Optimized Restore—Commvault selective copy

Instead of restoring the entire contents of the HPE Cloud Bank Store to the local HPE Catalyst Store (described in this section), a Commvault

selective copy may be used fo restore only specific backup jobs.

Consider the following scenario. Several cycles of full and incremental backups have been executed. Data aging has removed expired
backups from the primary copy based on the specified retention period. An older backup cycle needs to be restored from the secondary
copy. The following steps illustrate how to perform a selective restore from an HPE Cloud Bank Store to restore the expired backup.

1. From the CommCell browser, select Storage Policies = Storel - <copy name> = View = Jobs to view a list of all backup jobs
associated with both the primary and secondary copies. Review the listings to determine what jobs on the secondary copy are missing

from the primary copy.

2. To selectively restore data from the HPE Cloud Bank Store to the local HPE Catalyst Store, a third copy must be created for the “Storel”

storage policy.

a. From the CommCell browser navigation tree, select Storage Policies = Storel. Right-click and select All Tasks = Create New Copy.

b. Enter a Copy Name and choose a target Storage Pool. A new Storage Pool must be created the first time, which should point to the
Default Destination “HPE StoreOnce 5650 Storel” (the local HPE Catalyst Store).

c. Click Next twice, check the Selective Copy box, then click Finish. Select Storage Policies = Storel. Right-click and select Properties.

Figure 37 shows the Copy properties panel for the “Selective-Restore-Cloud-Bank-Store” Copy for the “Storel” storage policy.

@
o)
Associations Media Advanced

Copy Information
Copy Name:
Primary Copy
Selective Copy

Use Global Storage Policy

Default Destination

Library: HPE StoreOnce 5650 Store 1
MediaAgent:  fire-gi0wi
Drive Pool: /A

Description

Storage Policy Copy properties of Selective-Restore- Cloud-Bank-5Store X

Audit

General Retention CopyPolicy DataPaths Data Path Configuration Auxiiary Copy Fallen Behind  Selective Copy

Selective-Restore-Cloud-Bank-Store
Active
[] WORM Capy

HPE StoreOnce 5650 Pool

OK Cancel Help

Figure 37. Setting up a selective restore copy, the “Selective Copy” box must be checked fo activate the “Selective Copy” tab

3. At the top of the Copy Properties panel, select the Selective Copy tab. Click the Do not automatically select jobs radio button at the
bottom of the Selective Copy panel—this will deactivate the Automatically select Full Backups at frequency radio button.

4. At the top of the Copy Properties panel, select the Copy Policy tab. In the Backup Selection subpanel, uncheck All Backups. Use the
drop-down menu in the Backups Period field to specify a date to use when selecting the candidate jobs for restore. In the Source Copy
subpanel, check the Specify Source for Auxiliary Copy box. In the drop-down menu for this field, select “Secondary — Cloud Bank Store”
as the source for the Auxiliary Copy. Click OK, then click Yes to confirm that the source for this Auxiliary Copy is not the primary copy.
This completes the definition of the selective copy and displays the CommCell browser.

—
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The CommCell browser automatically displays a summary panel, shown in Figure 38, listing the copy definitions associated with the “Storel”
policy. Note the designated Copy Type for each copy.

| | Storel X
oo fre-glowl > | § Polides > ‘S Storage Policies > | | Store1 >

= Content

Copy Copy Type Status Default Library MediaAgent  Retain For

| Primary Primary M HPE StoreOnce 5650 Store1 fire-g10w1 0 days, 2 cydes
' # secondary - Cloud Bank Store Synchronous %] HPE Cloud Bank Store fire-glowl  0days, 12cydes
| & seelctive-Restore-Cloud-Bank-Store ‘ |~ HPE StoreOnce 5650 Store1 fire-gl0wl 30 days, 1cydes

Figure 38. Selective copy “Selective-Restore-Cloud-Bank-Store” added to the "Storel" storage policy

5. The Auxiliary Copy will not run now. In the Commvault browser navigation tree, right-click the “Selective-Restore-Cloud-Bank-Store”
copy under the “Storel” storage policy, then select View = Jobs. Uncheck Time Range to ensure that all available jobs will be listed.
Click the Advanced button at the bottom of the Job Filter for Storage Policy panel to display the Jobs in Storage Policy Advanced
Filter Options panel. Check the Jobs that will not be copied box as shown in Figure 39.

@ Jobs in Storage Policy Advanced Filter Options X
Filter by Data Status
[] Available
(4] Jobs that need to be copied
All jobs that need to be copied
[] Jobs that ran over 90 days ago (Critical)
] Jobs that ran over 30 and less than 90 days ago (Major)

[4] Jobs that ran over 7 and less than 30 days ago (Minor)

[4] Jobs that will not be copied

Aged Data
(@ Exdude Aged Jobs () Indude Aged Jobs () Show only Aged Jobs

[[] 3obs that are retained by Extended retention only
[[] Display jobs based on the storage policy time zone setting
oK Cancel Help

Figure 39. For a selective restore, the option fo display jobs that are not selected to be copied must be checked

6. Click OK twice to return to a displayed list of jobs available for copying from the HPE Cloud Bank Store (secondary copy) to the local
HPE Catalyst Store (primary copy). Figure 40 shows a sample list of backup jobs. Note that the Status column enftry is “Not Selected”

for each Job ID.

7. Highlight the backup jobs that are to be restored—multiple selections are supported. Right-click any of the highlighted entries and select
Pick for Copy from the menu. In Figure 40 the backup jobs for Cycle 29 (the full and three incremental jobs) have been selected for copy.
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615 R NotSelected [fire-g10w1

Send Logs
Pick for Data Verification
Do not Verify Data

Pick For Copy

619 % totsoced_fregiini__Wodows Sy fcaBocict_pioats__[ooenerlo/+___ i
55| % Notsdected AT M (T CTER T

W-ndor‘ ——

42 Jobs for Storage Policy -... X
l Jobs for Storage Policy — Storel, Copy-Selective-Restore-Cloud-Bank-Store
JobID  Status Client Seq... Duration Size of Application

632 € NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 32 /4 00:00:56 602.81MB
631 © NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Inaemental 32 /3 00:01:05 706.7 MB
630 e Not Selected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 32 /2 00:01:01 789.35 MB
628 © NotSelected fire-g10w1 Windows File System defaultBackupSet  MiniData Full 32/1 00:04:48 6.69GB
627 © NotSelected  fire-g10w1 Windows File System defaultBackupSet MiniData Incremental 31/ 4 00:00:51 621.26 MB
626 € NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 31/3 00:01:09 696.02 MB
625 © NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 31 /2 00:00:59 598.72 MB
624 © NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Full 31/1 00:04:16 6.69GB
623 € NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 30 /4 00:01:04 761.49 MB
622 € NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 30 /3 00:00:58 594,55 M8
621 © NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Incremental 30 /2 00:00:57 573.62 MB
{620 © NotSelected  fire-g10w1 Windows File System defaultBackupSet  MiniData Full 30/1 00:04:21 6.69 GB

658. 15 MB

709.55 MB

Figure 40. A full daily incremental cycle picked for a selective copy

8. Click Pick for Copy to initiate the copy operation. The Status field for the selected jobs will change to “To Be Copied.”
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9. (Follow substituting “Selective-Restore-Cloud-Bank-Store” in the steps 7-9 in the Optimized Restore—Commvault synchronous copy
View Jobs instruction in step 9). Be sure to follow the important note after section to monitor the progress of the copy operations
step 9 to deactivate this third copy.

Additional CommCell operations using HPE StoreOnce and HPE StoreEver

HPE StoreOnce and HPE StoreEver integrate with other Commvault features as well as backup and restore.

Auxiliary Copy to tape

As an alternative to using HPE Cloud Bank Storage for long-term, off-site storage, backups can be offloaded to tape. An HPE StoreEver

MSL6480 tape library with an LTO-8 tape drive was assigned to the Commvault media agent in the HPE solutions lab environment. From
the CommCell browser navigation tree, a new tape library was added (Storage Resources = Libraries > Add - Tape Library). A new
storage policy was created with the primary copy being directed to an HPE Catalyst Library. A secondary copy was added (Storage Policy
- <policy name> > All Tasks = Create New Copy) selecting the HPE MSL6480 library as the default destination. Full backups of a
subclient were performed with the secondary copy successfully written to the LTO-8 tape drive.

It is not desirable to have every backup operation (full, incremental, synthesized full) copied to tape. When setting the properties for a
secondary copy to tape, check the Properties = General = Selective Copy box. This activates the Selective Copy tab in the Copy
Properties panel. Select the Selective Copy tab fo display the Selective Copy panel shown in Figure 41, which permits selecting the
frequency of copying full backups to tape.
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® Copy Properties (Storage Policy : Stored) X

General Retention  Copy Policy Auxikary Copy Fallen Behind
Selective Copy Associations ~ Media  Advanced

Selective Copy
(® Automatically select Full Backups at frequencyl Weekly Fulls  + Advanced

For Daily Ful rule and Hourly Full rule, the day startson 12 : 00AM  |=]
For Weekly Full rule, the week starts on  Friday v
For Monthly Full rule, the month starts on
For each time period copy the:
(@ First full backup
(O Last full backup
Select most recent job if there are no more full badwp schedules in current time period

Wait until the current period is over before selecting a badwp for this time period

(O Do not Automatically select jobs

Figure 41. Specifying frequency of full backups for Auxiliary Copy fo tape

1-Touch recovery

Commvault provides the 1-Touch Bare Metal Recovery feature that allows a failed server to be recovered from a backup or allows creating a
clone of a server from a backup. The Catalyst Stores on an HPE StoreOnce appliance can be used to create a point-in-time recovery or a
clone of a Commvault Client server. In the HPE solutions lab, the appropriate 1-Touch recovery-point system state backups were created for
both the Linux and Windows clients (see Figure 4). The storage policies for each client specified an HPE Catalyst Store as the primary copy.
Both clients were successfully cloned to new virtual machines (VMs) using the most recent backups stored on the HPE StoreOnce appliance
as the source.

Live Mount

Commvault Virtual Server Agent (VSA) provides complete data protection and recovery for VM data. VSA supports a variety of hypervisors,
including VMware®. Live Mount is one of the many options supported by VSA. Live Mount enables running a VM directly from a stored
backup. This is useful for validating the integrity of the VM or accessing data without restoring guest files. Live-mounted VMs are intended
for short-term use. A Live Mount policy limits resource usage and time before the VM is decommissioned. In the HPE solutions lab, a
Windows VM client was backed up to an HPE StoreOnce appliance Catalyst Store. A Live Mount operation was initiated and a new VM was
automatically created and powered on as seen from the VMware vSphere® Web Client. Live Mounft creates a temporary NFS datastore for
the new VM as shown in Figure 42. From the HPE StoreOnce Management Console, select Reports = Backup/Restore to confirm that
data is being read from the HPE Catalyst Store as the host booted.

Getting Started Summary  Monitor Configure  Permissions  Hosts & Clusters  VMs | Datastores | Networks  Update Manager

[Datastores | Datastore Clusters | Datastore Folders ]

3 New Datastore.. | gfP Register WM. (g Browse Files (@ Refresh Capacity Information [} Manage Stor.. | 8§ Actions ~

Mame | Status Type Datastor... | Capacity Fres
B datastore1 @ Normal VMFS 5 436 TB 157 TB
] 3DFS_GX_BACKUP_0_ire-g... | @ Mormal NFS 3 128 TB 128 TB

Figure 42. Temporary NFS datastore created by Live Mount

The VMware Remote Console™ was used to log in to the new VM. Simple file operations and basic applications were executed to confirm
that the VM was functional. After one hour had passed (the default Live Mount policy setting), the temporary VM and the NFS datastore
were decommissioned.

—
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Commvault OnePass

The integration of Commvault OnePass™ and HPE StoreOnce Catalyst means that the Commvault ContentStore can reside on an

HPE Catalyst Store. It is possible to set up a tiered approach where recently created backups reside on a local HPE StoreOnce appliance
and older data is sent to HPE Cloud Bank Storage.

Summary

Hewlett Packard Enterprise and Commvault have collaborated to bring the benefits of HPE StoreOnce and HPE Catalyst to their customers.
The low-bandwidth and deduplication features of the HPE Catalyst protocol give Commvault customers the ability to perform backups
quickly and efficiently while maximizing data storage on HPE StoreOnce appliances or the cloud using HPE Cloud Bank Storage. The
integration effort improves the performance of Commvault Client backups in that each client can write directly to the HPE Catalyst Store
and not through a media agent first.

The HPE Catalyst Copy feature integrates with CommCell Auxiliary Copy to free the CommCell server from the overhead of copying data to
HPE Catalyst Stores at multiple locations. Commvault manages the backup copies, but the actual copy operation is handled enfirely between
the primary and secondary HPE Catalyst Stores. No data rehydration fakes place. HPE Cloud Bank Storage provides Commvault customers
the flexibility to write a secondary copy of data to object storage through Hyperscaler public cloud service providers.

The Commvault software integration with HPE StoreOnce Catalyst supports Commvault automated data aging and pruning. This allows the
multiple copies stored on HPE StoreOnce appliances o have their own data retention times to match the organization’s SLAs. Should data
need to be retrieved from HPE Cloud Bank Storage, Auxiliary Copy operations utilize the Catalyst Optimized Restore feature fo retrieve
unique, deduplicated data from the cloud, saving bandwidth and potential costs.

Commvault synthetic full backups directed to HPE StoreOnce appliances use the HPE Catalyst Clone feature to consolidate the full and
incremental backups held in an HPE Catalyst Store into a new Catalyst item. Catalyst Clone keeps the read and write overhead local to the
HPE StoreOnce appliance.

With the addition of ISV Controlled Data Immutability, data backup using Commvault software to an HPE StoreOnce appliance has never
been more secure, helping to protect against ransomware or malicious aftacks.

Commvault software integration with HPE StoreOnce Catalyst supports the entire HPE StoreOnce appliance portfolio.

Implementing a proof-of-concept with HPE StoreOnce VSA

As a matter of best practice for all deployments, Hewlett Packard Enterprise recommends implementing a proof-of-concept using a test
environment that matches as closely as possible the planned production environment. In this way, appropriate performance and scalability
characterizations can be obtained.

Implementing a proof-of-concept for Commvault software integration with HPE StoreOnce Catalyst can quickly be done for existing
Commvault customers through HPE StoreOnce VSA trialware. HPE StoreOnce VSA trialware enables a 90-day evaluation demo of all
HPE StoreOnce VSA features (including HPE Cloud Bank Storage) and up to 500 TB capacity. For product details and downloads, see
HPE StoreOnce VSA Gen4 90-Day Evaluation.


https://myenterpriselicense.hpe.com/cwp-ui/auth/login
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Resources
HPE Reference Architectures

HPE StoreOnce Data Protection Backup appliances
HPE StoreOnce VSA Gen4 90-Day Evaluation

HPE StoreOnce Support Matrix (HPE Passport account required)

Commvault Complete™ Backup & Recovery

To identify storage system configuration specifications and compatibility information, go to Single Point of Connectivity Knowledge (SPOCK)

HPE Storage
HPE Networking

HPE Greenlake Advisory and Professional Services

Learn more at Chat now
. — (sales)
HPE.com/us/en/storage/storeonce.html -
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